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Chapitre 1 : Introduction
Ce guide décrit la procédure d'utilisation d'un sys-
tème Avid® Interplay® Production pour échanger 
des médias entre des systèmes de montage vidéo 
Avid et des systèmes d'édition et de mixage audio 
Pro Tools®. Le logiciel Pro Tools HD est requis 
avec Interplay, avec ou sans matériel audio Avid 
Pro Tools|HD ou HD Native.

Pour consulter la liste des composants d'un 
système Interplay Production, reportez-vous 
à la section « Composants d'un système 
Interplay » à la page 2.

Interplay Production est désigné sous le nom 
d'Interplay dans le reste de ce guide.
Fonctionnalités d'Avid 
Interplay
Avid Interplay est un système de gestion des assets 
qui permet aux monteurs Avid et Pro Tools d'un 
même environnement de gérer et travailler avec les 
mêmes médias, de la manière suivante : 

• Exécuter des workflows sur les mêmes médias 
vidéo séquentiellement ou simultanément.

• Choisir entre plusieurs workflows pour le partage 
de fichiers.

• Assurer le monitoring, gérer et enregistrer des 
séquences vidéo.

• Revenir aux versions précédentes de séquences.

• Visualiser et gérer l'historique de séquences 
individuelles.
Chapitre 1 : Introduction 1
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Option Pro Tools Interplay
L'option Pro Tools Interplay permet aux monteurs 
Pro Tools d'interagir directement avec le système 
de gestion des assets Avid Interplay pour :

• Extraire des séquences.

• Éditer et mixer au sein d'une session Pro Tools.

• Exporter la session et tout nouveau média dans 
la séquence sur Interplay.

• Envoyer des séquences directement à des 
serveurs tiers pour une diffusion en temps réel 
(services Web Avid Interplay, Interplay Transfer 
et option Send to Playback de Pro Tools requis).

Vous pouvez également utiliser les applications 
Interplay Access et Interplay Administrator pour 
gérer et partager des fichiers directement avec un 
monteur Avid.
Guide Pro Tools Avid Interplay
Composants d'un système 
Interplay
Un système Avid Interplay destiné à être utilisé 
avec Pro Tools et des applications vidéo Avid 
comprend les composants suivants :

• Un système de stockage Avid MediaNetwork® 
ou ISIS® (emplacement de stockage de tous les 
médias)

• Un serveur Avid Interplay, pour la gestion
des métadonnées hébergées sur le serveur de 
stockage.

• Les applications Interplay suivantes (qui permet-
tent aux utilisateurs d'interagir directement avec 
Interplay) :
• Interplay Access
• Interplay Administrator

• Les applications logicielles suivantes (qui 
permettent aux utilisateurs d'enregistrer ou de 
récupérer des séquences à partir d'Interplay) :
• Logiciel Pro Tools HD avec option Pro Tools 

Interplay (vendue séparément)
• Une application de montage vidéo Avid 

compatible avec Interplay

• Les options logicielles suivantes (requises pour 
l'utilisation de la fonction Send to Playback) :
• Avid Interplay Transfer
• Services Web Avid Interplay
• Service Web Pro Tools Send to Playback

Reportez-vous au Chapitre 3, « Workflows 
Interplay pour Pro Tools et applications de 
montage vidéo Avid » pour consulter un schéma de 
l'environnement Avid Interplay décrit dans ce 
guide.

Pour obtenir des informations détaillées sur 
la configuration de composants d'un environ-
nement Avid Interplay non abordés dans ce 
guide, contactez un administrateur Interplay.



Systèmes de stockage Avid 
MediaNetwork et ISIS
Les systèmes Avid MediaNetwork sont des 
solutions de stockage réseau Fibre Channel haut 
débit pour stations de travail Avid et Pro Tools. 

Les systèmes Avid ISIS 7000 et ISIS 5000 sont des 
solutions de stockage réseau Gigabit Ethernet haut 
débit pour les stations de travail Avid.
Configuration requise et 
compatibilité
Les éléments suivants sont requis pour l'utilisation 
de l'option Pro Tools Interplay avec un système 
Interplay :

• Mac OS 10.6.8 ou supérieur
– ou –

• Windows 7

• Logiciel Pro Tools HD 

• Matériel optionnel Avid Pro Tools|HD ou HD 
Native

• Applications de montage vidéo Avid prises en 
charge par Avid Interplay 2.0 et supérieur 

• Connexion à un serveur Avid MediaNetwork ou 
ISIS

• DVD d'installation d'Avid Interplay

• Client Avid ISIS ou MediaNetwork configuré

Avid ne peut assurer une compatibilité des produits 
et fournir une assistance que pour les matériels et 
les logiciels testés et approuvés par ses soins. 

Pour connaître la configuration requise et consulter 
la liste exhaustive des ordinateurs, systèmes d'ex-
ploitation, disques durs et périphériques tiers pris 
en charge, rendez-vous sur :

www.avid.com/compatibility

Certaines fonctionnalités décrites dans ce guide 
requièrent le logiciel Media Composer 5 ou 
supérieur.
Chapitre 1 : Introduction 3
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À propos des guides Avid 
Interplay
Les versions PDF des fichiers Lisez-moi Avid sont 
installées automatiquement avec le logiciel Avid 
Interplay. Elles sont également disponibles dans 
les fichiers d'aide en ligne accessibles à partir des 
menus d'aide des applications Interplay Access et 
Interplay Administrator.

Vous pouvez utiliser n'importe lequel des 
guides suivants pour obtenir un supplément 
d'informations :

• Le Guide des bonnes pratiques Avid Interplay  
contient une présentation d'Avid Interplay, des 
instructions pratiques, ainsi que des informa-
tions conceptuelles et de référence nécessaires 
à l'utilisation du système Avid Interplay, notam-
ment des informations détaillées sur la configu-
ration d'une application de montage vidéo 
Avid (telle que Media Composer) dans un en-
vironnement Avid Interplay. Il est destiné à tous 
les utilisateurs Interplay, débutants ou experts.

• Le Guide d'installation et de configuration du 
logiciel Avid Interplay comporte une présenta-
tion de l'installation et des informations de 
configuration des composants Interplay du DVD 
d'installation d'Avid Interplay. Il est destiné aux 
administrateurs Interplay qui effectuent une mise 
à niveau de leur système ou installent intégra-
lement un nouveau système Avid Interplay.

• Le Guide de l'utilisateur Interplay comporte une 
introduction conceptuelle d'aide à la prise en 
main, ainsi que des explications détaillées sur 
les affichages à l'écran, les commandes et les 
processus. Il s'adresse à tous les utilisateurs 
finaux d'Avid Interplay qui souhaitent importer, 
rechercher et accéder à des master clips, des 
séquences et autres assets de l'environnement 
Avid MediaNetwork ou Avid ISIS dans le cadre 
de leurs activités quotidiennes. 
Guide Pro Tools Avid Interplay
• Le Guide d'administration Avid Interplay 
Engine et Avid Interplay Archive Engine explique 
comment installer, configurer et assurer la main-
tenance d'un système Avid Interplay (serveur 
et clients, ainsi que la totalité des connexions 
système et droits d'utilisateur associés). Il est 
destiné à tous les administrateurs Avid Interplay 
chargés de ces tâches.

• Le Guide de l'utilisateur et de la configuration 
d'Avid Interplay Transfer présente les procédures 
de configuration et d'utilisation de l'option 
logicielle Avid Interplay Transfer, requise pour 
l'utilisation de la commande Send to Playback 
avec Interplay.

• Le Guide des services Web Avid Interplay  
fournit des informations sur les services Web 
d'Interplay, tels que le service Web Pro Tools 
Send to Playback, requis pour l'utilisation de 
la commande Send to Playback avec Interplay.

Ces guides et les autres documentations sur 
Interplay sont disponibles sur le DVD Avid
Interplay Online Library et dans la base de 
connaissances Avid. Pour accéder à la base de 
connaissances, cliquez sur Help > Pro Tools 

Knowledge Base dans Pro Tools ou rendez-vous 
sur www.avid.com/support. Pour afficher ou 
imprimer les versions PDF, utilisez Adobe 
Reader.

Le menu Help de Pro Tools permet d'accéder 
à de nombreux guides connexes et à des aides 
contextuelles.



Conventions utilisées dans 
ce guide
Tous les guides Pro Tools utilisent les conventions 
suivantes pour indiquer les commandes de menu et 
les touches de raccourci :
 

Les noms des Commandes, Options et Paramètres 
qui apparaissent à l'écran sont affichés dans une 
autre police.

Les symboles suivants sont utilisés pour mettre 
en évidence des informations importantes :

Convention Action

File > Save Dans le menu File, 
sélectionnez Save

Ctrl+N Maintenez la touche Ctrl 
enfoncée et appuyez sur la 
touche N

Ctrl+clic Maintenez la touche Ctrl 
enfoncée et cliquez à l'aide 
du bouton de la souris

Effectuez un clic 
droit 

Cliquez à l’aide du bouton 
droit de la souris

Les conseils aux utilisateurs sont des astuces 
permettant d’optimiser l’utilisation du système.

Les avertissements importants contiennent des 
informations susceptibles de modifier vos 
données ou les performances du système.

Les raccourcis indiquent les commandes utiles 
du clavier et de la souris.

Les renvois dirigent l'utilisateur vers les sections 
correspondantes de ce guide et les autres guides 
d'Avid.
À propos de www.avid.com
Le site Web d'Avid (www.avid.com) est la meilleure 
source d'informations en ligne pour optimiser le 
fonctionnement de votre logiciel Pro Tools. Vous 
trouverez ci-après quelques exemples des services 
et fonctions disponibles à cette adresse. 

Enregistrement de produit : Enregistrez vos 
nouveaux produit en ligne. 

Assistance et téléchargements : Contactez le ser-
vice client Avid (assistance technique), téléchargez 
des mises à jour logicielles et les dernières versions 
des manuels en ligne, consultez les documents sur 
la compatibilité, parcourez la base de connaissances 
en ligne ou rejoignez la communauté d'utilisateurs 
Pro Tools, depuis la section User Conference. 

Formation et enseignement : Étudiez directement 
en ligne ou découvrez les méthodes de formation 
utilisées dans les centres de formation certifiés 
Pro Tools. 

Produits et développeurs : Découvrez les produits 
Avid, nos partenaires de développement ainsi 
que leurs plug-ins, applications et matériels, et 
téléchargez des versions démo de logiciels. 

Actualités et événements : Accédez aux
informations de dernière minute publiées par 
Avid et inscrivez-vous pour obtenir une démo de 
Pro Tools.
Chapitre 1 : Introduction 5
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Chapitre 2 : Installation de Pro Tools avec 
prise en charge d'Avid Interplay
Ce chapitre décrit les procédures d'installation 
et de configuration des applications Avid Interplay 
et des paramètres à utiliser avec Pro Tools.

Présentation de la 
configuration d'Interplay
pour l'enregistrement de 
contenus à partir de 
Pro Tools
L'installation de Pro Tools avec prise en charge 
d'Avid Interplay s'effectue en plusieurs étapes 
décrites ci-après, qu'il est nécessaire de suivre 
dans l'ordre exact indiqué : 

1  Installez votre système Pro Tools : reportez-vous 
au Guide d'installation de Pro Tools.

2  Installez Interplay Access sur votre système 
Pro Tools. Une fois Interplay Access installé, instal-
lez l'option Pro Tools Interplay sur votre système 
Pro Tools : reportez-vous à la section « Installation 
d'Interplay Access et de l'option Pro Tools Interplay 
sur un système Pro Tools » à la page 7.

Pour plus d'informations sur l'installation des 
applications Avid Interplay et la configuration 
des paramètres pour les applications de montage 
vidéo Avid, reportez-vous à la documentation 
Avid Interplay.
Chapitre 2 :
3  Facultatif : utilisez Interplay Administrator 
(installé avec Interplay Access) pour configurer 
les paramètres des plug-ins pour l'exportation 
de séquences Avid et l'importation dans Pro Tools. 
Reportez-vous à la section « Configuration des 
plug-ins d'exportation et d'importation 
d'Interplay Administrator » à la page 10.

4  Facultatif : contactez votre représentant commer-
cial ou technique Avid pour installer l'option Send 
to Playback. Pour plus d'informations sur l'option 
Send to Playback, reportez-vous à la section 
« Exportation de pistes audio éditées vers Interplay 
à partir de Pro Tools » à la page 25 .

Installation d'Interplay Access 
et de l'option Pro Tools Interplay 
sur un système Pro Tools
Cette section décrit comment installer Avid
Interplay Access et l'option Pro Tools Interplay sur 
un système Pro Tools. Pour plus d'informations, 
reportez-vous au Guide d'installation et de configu-
ration du logiciel Avid Interplay.

Vous devez réinstaller l'option Pro Tools 
Interplay à chaque mise à jour de Pro Tools.
 Installation de Pro Tools avec prise en charge d'Avid Interplay 7
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Pour installer Interplay Access et l'option 
Pro Tools Interplay sur un système Pro Tools basé 
sur Mac :

1  Vérifiez que votre système Pro Tools est installé 
avant de continuer.

2  Insérez le DVD d'installation d'Avid Interplay 
dans votre ordinateur. L'icône du DVD s'affiche 
sur le bureau.

3  Double-cliquez sur l'icône du DVD. Les dossiers 
et fichiers situés à la racine du DVD s'affichent.

4  Copiez le dossier Mac_Installers sur votre bureau.

5  Ouvrez le dossier Mac_Installers.

6  Ouvrez le dossier Access et double-cliquez sur 
le fichier InterplayAccessInstallerMac.zip.

7  Un programme intitulé « install » est 
décompressé et apparaît dans le dossier Downloads.

8  Double-cliquez sur Install. L'écran d'accueil du 
programme d'installation s'affiche.

9  Cliquez sur Next et poursuivez l'installation. 
Par défaut, Interplay Access est installé dans le 
dossier suivant : 

Applications\Avid\Avid Interplay Access

10  Dans le Finder, revenez au dossier 
Mac_Installers, localisez puis double-cliquez sur 
le programme d'installation Pro Tools Interplay 

Plug-In.

11  Suivez les instructions à l’écran pour finaliser 
le processus d'installation.

Si une version antérieure d'Interplay Access est 
présente, le programme d'installation la désins-
talle avant d'installer la version actuelle.
Guide Pro Tools Avid Interplay
Pour installer Interplay Access et l'option 
Pro Tools Interplay sur un système Pro Tools basé 
sur Windows :

1  Vérifiez que votre système Pro Tools est installé 
avant de continuer.

2  Insérez le DVD d'installation d'Interplay dans 
votre ordinateur.

3  Localisez le programme d'installation et 
double-cliquez dessus. La fenêtre du menu 
principal s’affiche.

4  Cliquez sur Clients. La fenêtre d'installation de 
client Interplay s'affiche. 

5  Cliquez sur Pro Tools Interplay Client. La fenêtre 
d'installation de client Pro Tools Interplay s'affiche.

6  Installez les composants suivants sur votre 
système Pro Tools :

Avid Interplay Access : Ce composant installe 
les applications Interplay Access et Interplay 
Administrator. 

Vous devez installer Interplay Access avant 
d'installer l'option Pro Tools Interplay.

Reportez-vous au Guide d'installation et de 
configuration du logiciel Avid Interplay.



Pro Tools Interplay Option : L'installation de ce 
composant effectue les opérations suivantes :

• Les fichiers d'activation relatifs à Interplay 
sont copiés dans le dossier d'installation de 
Pro Tools.

– et –
• Trois plug-ins sont installés (Pro Tools Import 

Settings, Pro Tools Export Settings et Editor 
Export Settings for Pro Tools) dans l'applica-
tion Interplay Administrator. 

7  Lorsque tous les composants ont été installés, 
cliquez sur Exit pour quitter le programme 
d'installation.

Au prochain lancement de Pro Tools, les options 
de menu suivantes seront disponibles :

• File > Import > Sequence from Avid Interplay.

• File > Export > Selected Tracks to Sequence in 

Avid Interplay

Réinstallation de l'option 
Pro Tools Interplay après la 
mise à jour de Pro Tools
L'option Pro Tools Interplay n'est pas conservée 
suite à la mise à jour de Pro Tools vers une 
version supérieure. Lorsque vous mettez à jour 
Pro Tools, vous devez réinstaller cette option.

Vous pouvez également installer l'option 
Pro Tools Interplay sur tout ordinateur du systè-
me Interplay. Vous pouvez ainsi permettre à 
un autre administrateur Interplay (un monteur 
Avid par exemple) de configurer les paramètres 
d'importation et d'exportation de Pro Tools.
Chapitre 2 :
À propos du dossier 
d'enregistrement de 
Pro Tools
Par défaut, la structure de dossiers de la base de 
données Interplay correspond à celle de l'appli-
cation de montage vidéo Avid. Avec Pro Tools 
versions 10 et ultérieures, le monteur Pro Tools a la 
possibilité d'extraire des séquences non-Pro Tools à 
partir d'Interplay. 

Dans de nombreux cas cependant, le monteur 
Avid a tout intérêt à enregistrer les séquences 
explicitement pour Pro Tools afin de s'assurer 
que les vidéos HD soient transcodées et que tous 
les effets vidéo soient calculés.

Lorsqu'un monteur Avid transfère une séquence 
sur Interplay pour Pro Tools, la base de données 
Interplay stocke deux versions distinctes de la 
séquence :

• La séquence d'origine. Elle est stockée à 
l'emplacement suivant :
Projects\nom_projet\noms_chutiers

• Une version spéciale de la séquence (appelée 
séquence Pro Tools). Elle est stockée dans un 
sous-dossier appelé Pro Tools à l'emplacement 
suivant :
Projects\nom_projet\nom_chutier\Pro Tools

Le monteur Pro Tools extraira ultérieurement la 
version de la séquence qui se trouve dans le dossier 
Pro Tools.

Structure de dossiers d'Avid Interplay Access

Dossier
Pro Tools

Nom du
projet

Nom du
chutier

Dossier
Projects
 
In
stallation de Pro Tools avec prise en charge d'Avid Interplay 9
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Définition du dossier de 
destination d'enregistrement
L'application de montage vidéo Avid sélectionne 
un dossier de destination d'enregistrement en 
fonction des paramètres de son dossier Interplay. 

Le monteur Avid peut utiliser les paramètres par 
défaut ou les modifier en ouvrant la boîte de dialo-
gue Interplay Folder Settings à partir de la fenêtre 
du projet.

Fenêtre de projet (application de montage vidéo Avid)

Boîte de dialogue Interplay Folder Settings

Paramètres 
Interplay 
Folder
Guide Pro Tools Avid Interplay
Configuration des plug-ins 
d'exportation et 
d'importation d'Interplay 
Administrator
Le programme d'installation de l'option Pro Tools 
Interplay ajoute les plug-ins suivants à l'application 
Interplay Administrator : 

• Editor Export Settings for Pro Tools
• Pro Tools Import Settings
• Pro Tools Export Settings

La configuration de ces plug-ins n'est pas 
obligatoire, mais elle permet de définir un ”modèle” 
de paramètres appliqué automatiquement aux 
séquences exportées à partir d'une application de 
montage vidéo Avid, importées dans Pro Tools 
ou exportées de Pro Tools.

Plug-ins de l'application Interplay Administrator

Paramètres 
d'importation 
de Pro Tools

Paramètres 
d'exportation du 

monteur pour 
Pro Tools

Paramètres 
d'exportation 
de Pro Tools



Configuration des paramètres 
d'exportation du monteur pour 
Pro Tools
Le plug-in Editor Export Settings for 
Pro Tools établit les paramètres par défaut pour 
l'application de montage vidéo Avid à appliquer 
lors de l'exportation d'une séquence vers Interplay 
pour Pro Tools.

Un monteur Avid (ou un administrateur Interplay) 
peut :

• Configurer le plug-in Editor Export Settings for 
Pro Tools avant d'exporter une séquence à partir 
du système de montage vidéo Avid.
– ou –

• Attendre le début du processus d'exportation 
(l'application de montage vidéo Avid demande 
alors les paramètres d'exportation). 

Le monteur Avid peut établir des paramètres 
d'exportation pour la totalité de la base de données 
ou pour des dossiers spécifiques. Les paramètres 
sont automatiquement hérités du projet ou du dos-
sier parent, et peuvent être modifiés explicitement 
dossier par dossier.

Avec Pro Tools versions 10 et ultérieures, le 
monteur Pro Tools a la possibilité d'extraire 
des séquences non-Pro Tools à partir 
d'Interplay. Dans de nombreux cas cependant, 
le monteur Avid a tout intérêt à enregistrer 
les séquences explicitement pour Pro Tools 
afin de s'assurer que les vidéos HD soient 
transcodées et que tous les effets vidéo soient 
calculés.
Chapitre 2 :
Pour configurer les paramètres d'exportation du 
monteur pour Pro Tools :

1  Dans la fenêtre Interplay Administrator, double-
cliquez sur le plug-in Editor Export Settings for 

Pro Tools pour l'ouvrir.

2  Configurez les paramètres d'exportation du 
monteur en fonction de la nature de votre projet. 
Pour plus d'informations, reportez-vous à la section 
« Paramètres d'exportation du monteur » à la 
page 12.

3  Cliquez sur le bouton Menu pour revenir à la 
fenêtre Administrator.

4  Cliquez sur Apply.

Paramètres d'exportation du monteur pour Pro Tools

Les modifications sont appliquées dans 
l'application de montage vidéo Avid lorsque 
le monteur se connecte à la fenêtre Interplay. 
Il se peut que le monteur doive se déconnecter 
puis se reconnecter à la fenêtre Interplay.
 Installation de Pro Tools avec prise en charge d'Avid Interplay 11
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Paramètres d'exportation du monteur

Cette section décrit en détail les paramètres 
disponibles dans la fenêtre Editor Export Settings.

Video Details

Transcode Video Resolution : L'application de 
montage vidéo Avid utilise ce paramètre pour 
effectuer un mixdown vidéo lorsque l'option Video 
Mixdown est sélectionnée après l'enregistrement 
de la séquence dans Interplay pour Pro Tools.

L'application peut également utiliser ce paramètre 
lorsque vous effectuez une exportation « lier au 
média existant ». 

Audio Details

Audio Mixdown : Indique si un mixdown audio 
doit être inclus avec chaque exportation. Les op-
tions disponibles sont Mono, Stereo et No Mixdown.

Convert Audio Sample Rate : Spécifie la fréquen-
ce d'échantillonnage audio pour l'exportation. 
L'option Project fait référence à la fréquence 
d'échantillonnage audio actuelle du projet Avid.

Convert Audio Bit Depth : Spécifie la résolution 
audio pour l'exportation. L'option Project fait 
référence à la résolution audio actuelle du projet 
Avid. Un dithering est automatiquement appliqué à 
l'audio dont la résolution est convertie. 

Pour plus d'informations, reportez-vous à la 
section « Enregistrement d'une séquence sur 
Interplay » à la page 20.

Ce paramètre est désactivé lors de l'exportation 
d'audio multipiste.
Guide Pro Tools Avid Interplay
Si les paramètres d'exportation du 
monteur pour Pro Tools ne sont pas 
configurés

Si le plug-in Editor Export Settings for Pro Tools 
n'est pas configuré pour un dossier particulier, 
l'application de montage vidéo Avid affiche la boîte 
de dialogue Pro Tools Export Settings lorsqu'une 
séquence est transférée vers Interplay pour 
Pro Tools. Le monteur Avid peut spécifier les 
paramètres pour cette exportation particulière dans 
la boîte de dialogue. 

Configuration des paramètres 
d'importation dans Pro Tools
Le plug-in Pro Tools Import Settings définit les 
paramètres par défaut utilisés par Pro Tools lors de 
l'importation d'une séquence à partir d'Interplay. 
Ces paramètres sont similaires à ceux utilisés par 
Pro Tools dans les boîtes de dialogue Import 
Session Data et New Session. 

Pour configurer les paramètres d'importation dans 
Pro Tools :

 Dans la fenêtre Interplay Administrator, double-
cliquez sur le plug-in Pro Tools Import Settings 
pour l'ouvrir.
 

Paramètres d'importation dans Pro Tools (vue 
complète)



Les paramètres sont automatiquement hérités du 
projet ou du dossier parent, et peuvent être modi-
fiés explicitement dossier par dossier. Vous pouvez 
également sélectionner un dossier individuel et 
définir des valeurs spécifiques pour ce dossier et ses 
sous-dossiers. 

Paramètres d'importation dans Pro Tools (liste de 
dossiers)

Si un administrateur n'a pas spécifié de para-
mètres dans le dossier Pro Tools ou un dossier 
parent, le monteur Pro Tools peut modifier ces 
paramètres dans les boîtes de dialogue New 
Session ou Import Session Data avant l'impor-
tation dans Pro Tools.

Paramètres configurés pour la 
base de données entière
Chapitre 2 :
Paramètres d'importation dans 
Pro Tools

Cette section décrit en détail les paramètres dispo-
nibles uniquement dans la fenêtre Pro Tools Import 
Settings d'Interplay Administrator.

Show Import Session Data Dialog on Import

Cette option permet de spécifier si Pro Tools doit 
afficher la boîte de dialogue Import Session Data 
lors de l'importation d'une séquence à partir 
d'Interplay. 

Même si tous les paramètres essentiels 
d'importation dans Pro Tools pour Interplay ont 
été prédéfinis, un utilisateur Pro Tools peut vouloir 
les modifier avant l'importation. Afin de pouvoir 
modifier ces paramètres, sélectionnez l'option Yes. 
Dans le cas inverse, sélectionnez l'option No.

Allow Import of non-PT Sequences

Avec Pro Tools versions 10 et ultérieures, le 
monteur Pro Tools a la possibilité d'extraire des 
séquences non-Pro Tools à partir d'Interplay. Dans 
de nombreux cas cependant, le monteur Avid a tout 
intérêt à enregistrer les séquences explicitement 
pour Pro Tools afin de s'assurer que les vidéos HD 
soient transcodées et que tous les effets vidéo soient 
calculés.

Si vous souhaitez que les utilisateurs Pro Tools 
puissent ouvrir des séquences standard, sélection-
nez l'option Yes. Si vous préférez empêcher les 
utilisateurs Pro Tools d'extraire des séquences 
standard, sélectionnez l'option No.

Reportez-vous au Guide de référence Pro Tools 
pour obtenir des informations détaillées sur les 
paramètres partagés par les boîtes de dialogue 
Import Session Data et New Session de 
Pro Tools.
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Configuration des paramètres 
d'exportation de Pro Tools
Le plug-in Pro Tools Export Settings définit les 
paramètres par défaut utilisés par Pro Tools pour 
l'exportation d'une séquence vers Interplay. Ces pa-
ramètres correspondent à de nombreux paramètres 
utilisés par Pro Tools dans la boîte de dialogue 
Export Options. 

Pour configurer les paramètres d'exportation de 
Pro Tools :

 Dans la fenêtre Interplay Administrator, double-
cliquez sur le plug-in Pro Tools Export Settings 
pour l'ouvrir.

Les paramètres sont automatiquement hérités 
du projet ou du dossier parent, et peuvent être 
modifiés explicitement dossier par dossier. Vous 
pouvez également sélectionner un dossier indi-
viduel et définir des valeurs spécifiques pour ce 
dossier et ses sous-dossiers. 

Paramètres d'exportation de Pro Tools (vue complète)

Si les paramètres d'exportation de Pro Tools ne 
sont pas configurés, il est possible de les définir 
dans Pro Tools lors de l'enregistrement de 
médias sur Interplay. Pour plus d'informations, 
reportez-vous à la section « Exportation de 
pistes audio éditées vers Interplay à partir de 
Pro Tools » à la page 25.
Guide Pro Tools Avid Interplay
Paramètres d'exportation de Pro Tools

Cette section décrit en détail les paramètres 
disponibles dans la fenêtre Pro Tools Export 
Settings.

Add/Replace Tracks 

Cette option permet de définir le comportement 
de création de pistes audio lorsqu'un utilisateur 
Pro Tools enregistre une nouvelle version de 
médias sur Interplay.

Add : Ajoute les pistes audio éditées à la séquence 
Pro Tools de la base de données Interplay. Choisis-
sez cette option si vous souhaitez conserver l'audio 
d'origine de la séquence.

Replace : Remplace les anciennes pistes audio de la 
séquence Pro Tools par les pistes audio éditées. 
Choisissez cette option si vous ne souhaitez pas 
conserver l'audio d'origine de la séquence. 

Export Stereo, 5.1, and 7.1 Tracks as Multi-
Channel

Cette option permet de choisir le format 
d'exportation de l'audio multicanal de Pro Tools 
vers Interplay. Activez cette option pour exporter 
les pistes multicanal sous la forme de fichiers audio 
multicanal entrelacés. Désactivez cette option pour 
exporter les pistes multicanal sous la forme de 
groupes de fichiers audio mono (un par canal).

Select Media Destination

Cette option permet de spécifier l'espace de travail 
dans lequel les médias sont enregistrés lorsqu'un 
utilisateur Pro Tools les transfère à nouveau sur 
Interplay. 

Ce paramètre est désactivé lors de l'exportation 
d'audio exclusivement mono ou de la tentative 
d'exportation d'un format audio surround non 
pris en charge (tel que LCRS ou 7.1 SDDS).



Same as Source : Cette option par défaut spécifie 
que les nouveaux éléments audio seront enregistrés 
dans l'espace de travail ISIS ou MediaNetwork 
contenant le premier clip sur la timeline de la 
séquence.

Select Workspace : Cette option permet d'enregis-
trer les nouveaux éléments audio dans le répertoire 
racine d'un autre espace de travail, sous réserve 
des permissions. Sélectionnez l'espace de travail 
souhaité à partir du menu Destination Workspace.

Send to Playback

Pro Tools permet d'envoyer des séquences finales 
à un serveur tiers afin de les envoyer à l'antenne. 
Pour cela, l'option Pro Tools Interplay, le service 
Web Pro Tools Send to Playback, un système 
Avid Interplay Transfer et les services Web Avid 
Interplay sont nécessaires. 

Send to Playback : Cette option permet de choisir 
si les séquences doivent être envoyées ou non à un 
serveur de diffusion tiers. 

Transfer Destination : Cette option permet de 
choisir la destination du transfert de la séquence 
parmi une liste de destinations disponibles.

Interplay Web Service IP Address : Cette option 
permet de spécifier l'adresse IP du serveur de 
services Web Interplay vers lequel l'envoi est prévu.

Session/Sequence Start Time Mismatch

Cette option permet de configurer le comportement 
de Pro Tools lors de l'exportation de pistes vers une 
séquence dont l'heure de début est différente de 
celle de la session Pro Tools actuelle. 

Adjust : Cette option redéfinit l 'heure de début 
de la session sur celle de la séquence.

Match Timecode :  Cette option fait correspondre 
les valeurs de timecode entre Pro Tools et Media 
Composer, seule la durée de la séquence originale 
est exportée.
Chapitre 2 :
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Chapitre 3 : Workflows Interplay pour 
Pro Tools et applications de montage vidéo 
Avid
Chapitre 3 : Workflows I
Figure 1. Schéma du système Avid Interplay
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Utilisez l'un des workflows suivants, en fonction de 
la configuration de votre système, pour transférer 
une séquence entre une application de montage 
vidéo Avid et Pro Tools et inversement à l'aide 
d'Avid Interplay :

Si le projet est en résolution HD et si le système 
Pro Tools est connecté à un système Video 
Satellite basé sur Media Composer :

1  Le monteur Avid exporte le projet HD à l'aide 
de l'option Link To Existing Media.

2  Le monteur Avid enregistre la séquence sur 
Interplay pour Pro Tools.

3  Le monteur Pro Tools importe une séquence à 
partir d'Interplay.

4  Le monteur Pro Tools ouvre la séquence avec une 
piste vidéo satellite et ouvre la séquence complète 
dans le système Video Satellite.

5  Le monteur Pro Tools exporte les pistes audio 
éditées et mixées vers la séquence stockée sur le 
serveur Interplay.

6  Le monteur Avid réimporte les pistes audio dans 
l'application de montage vidéo Avid.

Si le projet est dans une résolution HD et si le 
système Pro Tools n'utilise pas Video Satellite :

1  Le monteur Avid convertit le type du projet en 
résolution SD. 

2  Le monteur Avid enregistre la séquence sur 
Interplay pour Pro Tools.

3  Le monteur Pro Tools importe une séquence à 
partir d'Interplay.

4  Le monteur Pro Tools exporte les pistes audio 
éditées et mixées vers la séquence stockée sur le 
serveur Interplay.

5  Le monteur Avid réimporte les pistes audio dans 
l'application de montage vidéo Avid.
Guide Pro Tools Avid Interplay
Si le projet est en résolution SD :

1  Le monteur Avid enregistre la séquence sur 
Interplay pour Pro Tools.

2  Le monteur Pro Tools importe une séquence à 
partir d'Interplay.

3  Le monteur Pro Tools ouvre la séquence dans 
Pro Tools.

• Si Video Satellite est présent, le monteur peut 
ouvrir la séquence dans Pro Tools avec une 
piste vidéo satellite et ouvre la séquence 
complète dans le système Video Satellite.

• Si Video Satellite est absent, le monteur ouvre 
la séquence (avec vidéo) directement.

4  Le monteur Pro Tools exporte les pistes audio 
éditées et mixées vers la séquence stockée sur le 
serveur Interplay.

5  Le monteur Avid réimporte les pistes audio dans 
l'application de montage vidéo Avid.



Travail sur des projets HD
Avec un périphérique vidéo Avid, Pro Tools peut 
importer et afficher des métadonnées de montage 
provenant d'une vidéo HD Avid, mais ne peut 
ni lire ni afficher d'images vidéo HD. Lorsqu'un 
système Video Satellite est ajouté au système 
Pro Tools, il est possible de charger la séquence 
sur le système Video Satellite qui lira la vidéo HD 
via le périphérique vidéo Avid HD dans le logiciel 
Media Composer, synchronisé avec Pro Tools. 

Si le système Pro Tools n'est pas équipé de Video 
Satellite, les séquences exportées à partir des 
projets Avid HD doivent inclure un mixdown vidéo 
ou une piste vidéo transcodée dans une résolution 
SD correspondant à la résolution HD d'origine.
La modification de la résolution du transcodage 
ou du mixdown vidéo implique de changer le type 
de format du projet.

Pour de plus amples informations sur l'utilisa-
tion de Video Satellite, reportez-vous au Guide 
Video Satellite.
Chapitre 3 : Workflows I
Pour modifier le type d'un projet HD :

1  Ouvrez le projet dans l'application de montage 
vidéo Avid.

2  Dans la fenêtre du projet, cliquez sur l'onglet 
Format.

3  Choisissez une résolution SD correspondante 
dans le menu Project Type. Passez par exemple à 
un format 30i pour un projet NTSC 1080i/59.94, 
ou à un format 25i pour un projet PAL 1080i/50.

Onglet Format de la fenêtre de projet

Aucune résolution SD ne correspond aux projets 
720p. 

Il est également possible dans les environ-
nements Interplay 2.4 ou supérieur et Pro Tools 
10 ou supérieur, de lancer le service Interplay 
Transcode pour prendre en charge le transco-
dage d'un format de projet à l'autre, et ainsi de 
décharger le système de montage vidéo Avid du 
processus de transcodage HD en SD sur le service 
Transcode. Cette option peut être configurée lors 
d'une procédure d'enregistrement standard sur 
Interplay à partir du monteur vidéo Avid (mais 
non lors d'un enregistrement pour Pro Tools). 
Pro Tools 10 et supérieur peut importer des 
séquences qui n'ont pas été explicitement en-
registrées pour Pro Tools.
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Enregistrement d'une 
séquence sur Interplay
Cette section décrit la procédure d'enregistrement 
d'une séquence sur Interplay à partir d'une applica-
tion de montage vidéo Avid, de l'une des manières 
suivantes : 

• enregistrement d'une séquence sur Interplay 
pour Pro Tools ;

• enregistrement d'une séquence standard sur 
Interplay.

Enregistrement de séquences sur 
Interplay pour Pro Tools

Avec Pro Tools versions 10 et ultérieures, le 
monteur Pro Tools a la possibilité d'extraire des 
séquences non-Pro Tools à partir d'Interplay. Dans 
de nombreux cas cependant, le monteur Avid a tout 
intérêt à enregistrer les séquences explicitement 
pour Pro Tools afin de s'assurer que les vidéos HD 
soient transcodées et que tous les effets vidéo soient 
calculés.

Pour enregistrer une séquence sur Interplay pour 
Pro Tools :

1  Naviguez jusqu'au chutier contenant la séquence 
que vous souhaitez exporter.

2  Effectuez l'une des opérations suivantes :
• Sélectionnez la séquence et choisissez File > 

Check In to Interplay for Pro Tools.

Chutier contenant la séquence à exporter
Guide Pro Tools Avid Interplay
– ou –
• Effectuez un clic droit sur la séquence et 

sélectionnez File > Check In to Interplay for 

Pro Tools.

3  Si vous avez configuré au préalable les paramètres 
d'exportation du monteur pour Pro Tools pour le 
dossier, sélectionnez une option dans la boîte de 
dialogue Pro Tools Video Options.

Link to existing video media : Lorsque cette 
option est sélectionnée, la vidéo n'est jamais 
transcodée ni copiée. Au contraire, c'est toujours le 
média vidéo d'origine qui est utilisé. Cette option 
est utile pour les utilisateurs de Video Satellite qui 
souhaitent importer une piste satellite (points de 
montage uniquement). 

Si la case Render video effects est sélectionnée, 
tous les effets vidéo seront calculés.

Transcode video : Transcode la vidéo à la résolu-
tion spécifiée dans les paramètres d'exportation 
de Pro Tools et calcule tous les effets. Cette option 
n'est pas disponible pour les projets aux formats 
720p et 1080. Si le média a déjà été transcodé, il ne 
le sera pas à nouveau. Si seuls certains fichiers 
doivent être transcodés, seuls ceux-là le seront. 

Si vous choisissez cette option pour un projet 
720p ou 1080, vous ne pourrez pas lire le média 
vidéo dans Pro Tools (même s'il peut être lu par 
le système Video Satellite).

Les effets calculés sur le lecteur C: ne seront 
pas offline sur le système Pro Tools. Veillez 
à configurer les paramètres de création de 
médias de sorte que les effets soient calculés 
sur un volume réseau accessible à tous les 
utilisateurs de Pro Tools.



New video mixdown :  Exporte un mixdown vidéo 
en utilisant la résolution de transcodage vidéo 
spécifiée dans la boîte de dialogue Editor Export 
Settings ou Pro Tools Export Settings. Cette option 
n'est pas disponible pour les projets aux formats 
720p et 1080. 

4  Cliquez sur OK pour enregistrer la séquence 
sur Interplay.

Enregistrement de séquences standard 
sur Interplay

À partir de la version 10, Pro Tools permet d'ex-
traire des séquences normales à partir d'Interplay. 
Dans certains cas, pour des raisons pratiques ou 
d'organisation, le monteur Avid doit enregistrer 
des séquences à l'intention particulière des utilisa-
teurs Pro Tools. Si vous préférez enregistrer une 
séquence standard, procédez comme suit :

Pour enregistrer une séquence Avid standard sur 
Interplay :

1  Naviguez jusqu'au chutier contenant la séquence 
que vous souhaitez exporter.

2  Effectuez l'une des opérations suivantes :
• Sélectionnez la séquence et choisissez File > 

Check In to Interplay.
– ou –
• Effectuez un clic droit sur la séquence et 

sélectionnez Check In to Interplay.

3  Cliquez sur OK pour enregistrer la séquence 
sur Interplay.

Chutier contenant la séquence à exporter
Chapitre 3 : Workflows I
Après avoir enregistré une 
séquence sur Interplay
Le système exporte la séquence à partir de l'applica-
tion de montage vidéo Avid, puis l'enregistre sur 
Interplay.

Lors de l'enregistrement d'une séquence sur 
Interplay pour Pro Tools, si le dossier Interplay 
qui contient la séquence exportée a été configuré 
avec des paramètres vidéo et audio définis dans 
le plug-in Editor Export Settings for Pro Tools, 
ces paramètres sont appliqués à la séquence. 
Ces paramètres peuvent s'appliquer soit à la base de 
données entière, soit à un ou plusieurs dossiers, 
suivant leur configuration.

Si les paramètres du dossier de destination de 
l'enregistrement n'ont pas été définis, le système 
affiche la boîte de dialogue Pro Tools Export 
Settings pour permettre au monteur Avid de les 
spécifier. 

Lorsqu'un monteur Avid enregistre une séquence 
sur Interplay, le système sélectionne un dossier de 
destination dans la base de données Interplay en 
fonction des paramètres d'affichage d'Interplay 
actuels, le dossier de destination par défaut étant 
le suivant :

Projects\nom_projet\nom_chutier

Reportez-vous à la section « Configuration des 
paramètres d'exportation du monteur pour 
Pro Tools » à la page 11.

Pour plus d'informations, reportez-vous à la 
section « À propos du dossier d'enregistrement 
de Pro Tools » à la page 9.
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Marges audio
Lorsqu'une séquence est transférée à partir de 
Media Composer pour Pro Tools, des marges de 
deux secondes sont ajoutées à tous les clips audio. 
Si des données audio sous-jacentes sont disponi-
bles, un trim peut être appliqué aux débuts et fins 
des clips (sur une plage de deux secondes maxi-
mum), à l'aide de l'outil de trim de Pro Tools.

Fichiers exportés dans Interplay
Lorsqu'un monteur Avid enregistre une séquence 
pour la première fois sur Interplay, le système 
effectue les opérations suivantes :

• il enregistre la séquence Avid dans le dossier 
nom_chutier ;

• il crée la nouvelle séquence exportée selon 
les paramètres d'exportation définis dans 
l'outil Interplay Administration ou la boîte 
de dialogue Pro Tools Export Settings.

Si la séquence a été enregistrée sur Interplay 
pour Pro Tools, le système effectue également 
les opérations suivantes :

• il crée un sous-dossier Pro Tools dans le 
dossier nom_chutier ;

• il enregistre les fichiers pour le monteur 
Pro Tools dans le sous-dossier Pro Tools ;

• il enregistre une séquence Pro Tools dans le 
sous-dossier Pro Tools.

Emplacement de la séquence Avid et du répertoire 
Pro Tools associé 

Le nom de la séquence
correspond à celui qui se trouve dans le chutier de

l'application de montage vidéo Avid
Guide Pro Tools Avid Interplay
Conventions d'attribution des noms aux 
séquences pour l'enregistrement sur 
Interplay pour Pro Tools

À la première exportation d'une séquence pour 
Pro Tools, le système ajoute le texte « _forPT_1 » 
au nom de la séquence dans le dossier Pro Tools. 
Par la suite, à chaque fois que la séquence est 
exportée, le système ajoute le texte « _forPT_2 », 
« _forPT_3 » (numérotation incrémentielle) et 
ainsi de suite au nom de la séquence.

L'illustration suivante représente le contenu du 
répertoire Pro Tools après la première exportation.

Contenu du répertoire Pro Tools (volet de gauche) et 
séquence stockée dans ce répertoire (volet de droite)

Les points rouges dans l'interface graphique 
indiquent que le système a réservé les fichiers 
pour éviter toute suppression non autorisée 
pendant une durée déterminée. Pour plus 
d'informations, reportez-vous au Guide de 
l'utilisateur Avid Interplay Access.

Points rouges « _forPT_1 » ajouté au 
nom de la séquence



Gestion des séquences 
« _forPT_x »
À chaque fois qu'une nouvelle version d'une 
séquence précédemment enregistrée sur Interplay 
pour Pro Tools est enregistrée par un monteur 
Avid, le texte « _forPT_x » est ajouté de façon 
incrémentielle au nom de la séquence.

Dans cet exemple, une séquence intitulée 
Wild_Light a été enregistrée trois fois pour 
Pro Tools. Un monteur récupère la séquence 
Wild_Light_forPT_1, la révise et l 'enregistre à 
nouveau pour Pro Tools, créant ainsi la séquence 
Wild_Light_forPT_4. 

Pour plus d'efficacité, si vous extrayez un fichier 
« forPT » et le modifiez, il est conseillé de modi-
fier son nom pour refléter les modifications. 
Vous pouvez également utiliser le champ des 
commentaires lors de l'extraction pour indiquer 
à partir de quelle séquence cette version a été 
créée.

Wild_Light_forPT_1

Wild_Light_forPT_2

Wild_Light_forPT_3

Wild_Light_forPT_1
Wild_Light_forPT_2
Wild_Light_forPT_3
Wild_Light_forPT_4

Monteur 

Monteur 

extraction

enregistrement
Chapitre 3 : Workflows I
Importation d'une séquence 
dans Pro Tools à partir 
d'Interplay
Cette section décrit comment rechercher une 
séquence dans la base de données Interplay et 
l'importer dans Pro Tools. Elle requiert que vous 
ayez déjà configuré les paramètres d'importation de 
Pro Tools dans l'outil Interplay Administration. 

Si vous ne définissez pas les paramètres d'importa-
tion de Pro Tools avant d'importer la séquence dans 
Pro Tools, vous pouvez sélectionner les valeurs 
appropriées à partir de la boîte de dialogue Session 
Data au cours de la procédure d'importation.

Lorsque vous importez une séquence à partir 
d'Interplay dans Pro Tools, vous pouvez l'importer 
dans une session nouvelle ou existante. 

Importation d'une séquence 
dans Pro Tools à partir 
d'Interplay

Pour utiliser une séquence d'Interplay et l'importer 
dans Pro Tools à partir d'Avid Interplay Access :

1  Lancez Avid Interplay Access.

2  Naviguez jusqu'au dossier contenant la séquence 
que vous souhaitez importer.

Pour plus d'informations, reportez-vous à la 
section « Configuration des paramètres 
d'importation dans Pro Tools » à la page 12.

Pour plus d'informations sur l'utilisation du 
navigateur d'Avid Interplay Access, reportez-
vous au Guide de l'utilisateur Avid Interplay 
Access.

Les séquences « forPT » sont stockées dans un 
sous-dossier (de la séquence principale) appelé 
« Pro Tools ».
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3  Effectuez un clic droit sur la séquence et 
sélectionnez Import to Pro Tools.

Si Pro Tools n'est pas déjà en cours d'exécution, 
il se lance automatiquement.

Importation d'une séquence 
Interplay à partir de Pro Tools
Cette section décrit comment utiliser Pro Tools 
pour importer une séquence à partir d'Interplay.

Pour extraire la séquence et l'importer dans 
Pro Tools à partir de Pro Tools :

1  Lancez Pro Tools.

2  Si vous souhaitez importer la séquence dans une 
session existante, ouvrez cette session.

3  Sélectionnez File > Import > Sequence from Avid 

Interplay. La fenêtre Interplay Access apparaît.

4  Naviguez jusqu'au dossier contenant la séquence 
que vous souhaitez importer.

5  Effectuez un clic droit sur la séquence et 
sélectionnez Import to Pro Tools.

6  Cliquez sur OK. 

7  Si la boîte de dialogue Name the Session apparaît, 
naviguez jusqu'à l'emplacement adéquat sur un 
emplacement de stockage local ou sur un espace de 
travail réseau dédié, et cliquez sur Save.

Les séquences « forPT » sont stockées dans un 
sous-dossier (de la séquence principale) appelé 
« Pro Tools ».

Cette boîte de dialogue n'apparaît pas si vous 
importez une séquence dans une session 
existante.
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8  Si la boîte de dialogue Import Session Data 
de Pro Tools apparaît, sélectionnez les options 
appropriées et cliquez sur OK.

Boîte de dialogue Import Session Data

Cette boîte de dialogue ne s'affiche pas 
si vous avez configuré les paramètres d'im-
portation de Pro Tools dans Avid Interplay 
Administrator. Pro Tools utilise ces paramètres 
automatiquement pour l'importation de la 
séquence. Reportez-vous à la section 
« Configuration des paramètres d'importa-
tion dans Pro Tools » à la page 12 pour obte-
nir des informations détaillées sur la confi-
guration des paramètres d'importation de 
Pro Tools et au guide de référence Pro Tools 
pour des informations détaillées sur les options 
de configuration de cette boîte de dialogue.



Pro Tools importe la séquence, copie les médias 
(si les paramètres requièrent une copie) et affiche 
la séquence importée au sein de la session de 
Pro Tools. 

Si la séquence est liée à des fichiers média stockés 
sur des volumes non montés, le système affiche 
alors un avertissement et vous invite à monter ces 
volumes avant de poursuivre la copie des fichiers 
ou la liaison avec ces fichiers.

Séquence importée à partir d'Interplay dans la 
timeline
Chapitre 3 : Workflows I
Exportation de pistes audio 
éditées vers Interplay à 
partir de Pro Tools
Après avoir édité le contenu audio de la séquence, 
vous pouvez exporter les pistes audio vers la 
séquence sur Interplay.

Pour exporter des pistes audio à partir de 
Pro Tools, puis les enregistrer sur Interplay :

1  Dans Pro Tools, sélectionnez les pistes que vous 
souhaitez exporter vers la séquence Pro Tools sur 
Interplay.

2  Sélectionnez File > Export > Selected Tracks to 

Sequence in Avid Interplay.

Il est conseillé d'utiliser des stems audio finaux 
plutôt que des pistes audio avec des points 
d'édition.

Si une nouvelle version de la séquence sur 
laquelle vous travaillez a été enregistrée par 
un monteur Avid, Pro Tools affiche la boîte de 
dialogue New Version Exists. Vous avez alors 
la possibilité d'importer la nouvelle séquence 
et de mettre à jour l'audio, de continuer votre 
exportation vers la séquence actuelle ou d'expor-
ter directement vers une version mise à jour 
de la séquence. Pour plus d'informations, repor-
tez-vous à la section « Exportation de pistes 
audio éditées vers une séquence alternative » 
à la page 28.
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3  Dans la boîte de dialogue Export Comment, 
saisissez un commentaire et cliquez sur OK.

La boîte de dialogue Export Options s'affiche.

4  Dans la boîte de dialogue Export Options, 
sélectionnez une méthode de report des contenus 
audio édités dans la séquence Pro Tools située 
sur le serveur Interplay :

Replace with Selected Tracks : Remplace les 
anciennes pistes audio de la séquence Pro Tools par 
les pistes audio éditées. Choisissez cette option si 
vous ne souhaitez pas conserver l'audio d'origine de 
la séquence. 

Add Selected Tracks : Ajoute les pistes audio édi-
tées à la séquence Pro Tools de la base de données 
Interplay. Choisissez cette option si vous souhaitez 
conserver l'audio d'origine de la séquence.

Export Stereo, 5.1, and 7.1 Tracks as Multi-
Channel : Cette option permet de choisir le format 
d'exportation de l'audio multicanal de Pro Tools 
vers Interplay. Activez cette option pour exporter 
les pistes multicanal sous la forme de pistes 

Boîte de dialogue Export Options
Guide Pro Tools Avid Interplay
multicanal plutôt que de les diviser en pistes mono. 
Désactivez cette option pour exporter les pistes 
multicanal sous la forme de groupes de pistes mono 
(une par canal).

5  Si vous souhaitez envoyer la séquence actuelle 
à un serveur de diffusion tiers, configurez les 
paramètres dans la section Send To Playback de 
la boîte de dialogue Export Options. 

Send : Cette option permet de choisir si les séquen-
ces doivent être envoyées ou non à un serveur de 
diffusion tiers.

Web Service Address : Cette option permet de 
spécifier l'adresse IP du serveur de services Web 
Interplay auquel vous souhaitez vous connecter.

Playback Address : Cette option permet de 
choisir la destination du transfert de la séquence 
parmi une liste de destinations disponibles.

Ce paramètre est désactivé lors de l'exportation 
d'audio exclusivement mono ou de la tentative 
d'exportation d'un format audio surround non 
pris en charge tel que (LCRS ou 7.1 SDDS).

La fonction Send to Playback requiert un ser-
veur Interplay Transfer (configuré pour prendre 
en charge les commandes Send to Playback vers 
les destinations requises), les services Web Avid 
Interplay et le service Web Pro Tools Send to 
Playback.

La commande Send to Playback fonctionne 
uniquement lorsque l'option Replace With 
Selected Tracks est activée. 



6  Dans la section Select Media Destination de la 
boîte de dialogue Export Options, choisissez la 
destination de votre nouveau média parmi les 
options suivantes :

Same as Source : Cette option par défaut enregis-
tre les nouveaux éléments audio dans le même 
espace de travail Interplay que celui qui contient 
le premier clip sur la timeline de la séquence.

Select Workspace : Cette option permet d'enregis-
trer les nouveaux éléments audio dans le répertoire 
racine d'un autre espace de travail, sous réserve 
des permissions. Cliquez sur le bouton Select 

Workspace pour ouvrir la boîte de dialogue Select 
Media Destination dans laquelle vous pouvez 
spécifier l'espace de travail de votre choix.

7  Cliquez sur OK.

8  Si l'heure de début de la session Pro Tools est 
différente de celle de la séquence d'exportation, 
choisissez une des options suivantes dans la boîte 
de dialogue d'avertissement qui s'affiche :

Cancel : Cette option arrête l'exportation.

Match Timecode :  Cette option fait correspondre 
les valeurs de timecode entre Pro Tools et Media 
Composer, seule la durée de la séquence originale 
est exportée. Tout l'audio situé en dehors des 
limites de la séquence est exclu.

Adjust : Cette option redéfinit l'heure de début de 
la session sur celle de la séquence.

Boîte de dialogue d'avertissement sur l'heure de début 
de la session
Chapitre 3 : Workflows I
9  Dans la boîte de dialogue de confirmation, 
confirmez votre sélection.

La séquence dans la base de données Avid Interplay 
est maintenant prête à être extraite et importée par 
le monteur Avid.

Messages d'erreur Send to 
Playback
Lors de l'utilisation de la commande Send To 
Playback, des messages d'erreur spéciaux s'af-
fichent lorsque l'envoi vers le serveur de diffusion 
s'avère impossible. Si l'un de ces messages s'affiche, 
reportez-vous à son explication pour rechercher le 
problème.

Offline Media : La séquence contient un média 
offline.

Unrendered Effects : La séquence contient des 
effets non calculés.

Tape ID : La séquence ne contient pas d'ID de 
bande. Entrez l'ID de bande correct ou cliquez sur 
Cancel pour annuler l'opération Send To Playback.

Invalid Tape ID : L'ID de bande de la séquence est 
incorrect. Cliquez sur OK pour ouvrir l'option 
Tape ID dans laquelle vous pouvez saisir l'ID de 
bande correct.

Playback Server Could Not Connect

Le serveur de diffusion est indisponible, car il 
n'est pas démarré ou il est bloqué par un pare-
feu réseau. 

Pour vérifier votre connexion au serveur de dif-
fusion, utilisez un client FTP ou un programme 
de terminal FTP de ligne de commande pour es-
sayer d'accéder au répertoire des fichiers requis. 
Pour obtenir de l'aide supplémentaire, contactez 
votre administrateur réseau Interplay.
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Invalid WebService Address or Connection

L'adresse IP du service Web saisie est indisponible. 
Il se peut que la connexion Interplay soit interrom-
pue, que l'adresse IP soit incorrecte ou que le 
service Web soit hors ligne.

Exportation de pistes audio 
éditées vers une séquence 
alternative
Dans de nombreux workflows de post-production, 
il est courant que le monteur Avid travaille sur une 
séquence, alors que le monteur Pro Tools utilise 
l'audio provenant de la version précédente. 

Dans ce cas de figure, lorsque le monteur 
Pro Tools s'apprête à réexporter les pistes audio 
vers Interplay, Pro Tools avertit l 'utilisateur de 
l'existence d'une nouvelle version alternative de la 
séquence et propose différentes solutions.

Pour exporter des pistes audio éditées vers 
Interplay lorsqu'une version plus récente de la 
séquence existe sur Interplay :

1  Dans Pro Tools, sélectionnez les pistes que vous 
souhaitez exporter vers la nouvelle version de la 
séquence Pro Tools sur Interplay.

2  Sélectionnez File > Export > Selected Tracks to 

Sequence in Avid Interplay.
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3  Lorsque Pro Tools ouvre la boîte de dialogue 
New Version Exists, choisissez l'une des options 
suivantes :

Import Latest Version into Current Session : 

Cette option annule l'action d'exportation actuelle 
et importe les données de la nouvelle séquence dans 
la session Pro Tools actuelle. Elle est sélectionnée 
par défaut.

Export Selected Audio Tracks to Original 
Sequence : Cette option permet d'exporter les 
pistes audio sélectionnées vers la version originale 
de la séquence sur Interplay. Il s'agit de la séquence 
à laquelle la session Pro Tools est actuellement 
associée.

Boîte de dialogue New Version Exists

Cette option est particulièrement utile dans 
les situations où des éléments liés à la timeline 
ont été modifiés dans la séquence. Dans ces cas 
de figure, il est important d'importer la nouvelle 
séquence dans Pro Tools et d'apporter les 
modifications audio nécessaires avant de la 
réexporter vers Interplay.

Cette option est particulièrement utile lorsque 
plusieurs révisions d'une séquence sont délibéré-
ment conservées et utilisées séparément.



Export Selected Audio Tracks to Alternate 
Sequence : Cette option permet de choisir une 
version alternative de la séquence d'exportation 
sur Interplay.

4  Pro Tools ouvre alors la boîte de dialogue Select 
Alternate Sequence qui affiche toutes les versions 
associées de la séquence actuelle. La dernière 
version est sélectionnée par défaut.

Cette option est particulièrement utile dans les 
situations où des éléments non liés à la synchro-
nisation (titres ou correction colorimétrique) 
ont été modifiés. Si la position ou l'ordre des 
éléments dans la séquence a été modifié, la réex-
portation des données audio vers la séquence 
alternative risque de provoquer des problèmes 
de synchronisation. Dans ces cas de figure, 
importez la nouvelle séquence dans Pro Tools 
et apportez les modifications audio nécessaires 
avant de la réexporter vers Interplay.

Si un autre monteur Pro Tools du système 
Interplay a extrait la version originale de la 
séquence et réexporté des pistes éditées vers 
Interplay, Pro Tools affiche la boîte de dialogue 
New Version Exists lorsque vous essayez 
d'enregistrer de nouveaux éléments audio. 
Toutefois, l'option Export Tracks to Alternate 
Sequence apparaît en grisé.

Boîte de dialogue Select Alternate Sequence
Chapitre 3 : Workflows I
Effectuez l'une des opérations suivantes :
• Si vous souhaitez exporter vos données audio 

vers la version alternative la plus récente de la 
séquence, cliquez sur OK.

– ou –
• Si vous souhaitez exporter vos données audio 

vers une version alternative plus ancienne de 
la séquence, sélectionnez-la et cliquez sur OK. 

L'exportation simultanée vers plusieurs 
séquences est impossible.

La version actuelle de la séquence est affichée 
dans la liste, à titre de référence, mais en grisé. 
Pour exporter vers la version actuelle de la 
séquence, choisissez l'option Export Selected 
Audio Tracks to Original Sequence dans la 
boîte de dialogue New Version Exists.
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Réimportation de fichiers 
audio Pro Tools dans 
l'application de montage 
vidéo Avid
Après avoir enregistré les stems audio finaux dans 
la séquence Pro Tools sur le serveur Interplay, 
le monteur Avid importe à nouveau la séquence 
dans l'application de montage vidéo Avid.

Pour réimporter la séquence dans l'application de 
montage vidéo Avid :

1  Dans l'application de montage vidéo Avid, ouvrez 
la fenêtre Interplay et naviguez jusqu'à l'emplace-
ment de la séquence Pro Tools enregistrée.

2  Faites glisser la séquence vers le chutier.

L'application de montage vidéo Avid extrait la 
séquence et l'importe, ainsi que les fichiers 
associés, dans le chutier.

3  Le monteur Avid peut effectuer l'une des 
opérations suivantes : 

• Ajouter les nouvelles pistes audio à la 
séquence originale.

– ou –
• Travailler avec la séquence importée.

En fonction des modifications apportées dans 
Pro Tools, plusieurs fichiers audio peuvent 
apparaître, avec des noms comportant le préfixe 
« Sample accurate edit ». Pour plus d'informa-
tions, reportez-vous à la section « Montage vi-
déo avec précision à l'image et édition audio 
avec précision à l'échantillon » à la page 31.
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Dans cet exemple, les pistes audio Pro Tools sont 
ajoutées à la séquence originale.

4  Chargez la séquence importée dans le moniteur 
Source.

5  Ajoutez l'audio à la séquence originale à l'aide 
des techniques de montage standard. 

6  Le monteur Avid peut ensuite effectuer les 
ajustements de son choix et les opérations 
suivantes :

• Créer un report sur bande.
• Exécuter une commande Send to Playback.
• Enregistrer la séquence sur Interplay pour 

Pro Tools si le monteur Pro Tools doit 
travailler à nouveau sur la séquence.

Si vous prévoyez d'enregistrer à nouveau la 
séquence sur Interplay pour Pro Tools, le plus 
simple consiste à importer l'audio dans la 
séquence originale. À chaque fois que vous 
exportez une séquence pour Pro Tools, le 
système ajoute le texte « _forPT_x », où x 
correspond au nombre d'exportations de la 
séquence. Cela peut porter à confusion si 
plusieurs chaînes de texte similaires sont 
ajoutées au nom.

Pour plus d'informations, reportez-vous à la 
documentation (PDF ou fichier d'aide) de votre 
application de montage vidéo Avid.



Montage vidéo avec précision à 
l'image et édition audio avec 
précision à l'échantillon
Lorsqu'une séquence a été de nouveau exportée vers 
Interplay à partir de Pro Tools, un certain nombre 
de fichiers média sont affichés dans la fenêtre 
d'Interplay et dans le chutier. Les noms de certains 
comportent le préfixe Sample accurate edit.  Il 
s'agit des fichiers média supplémentaires créés 
par Pro Tools pour s'assurer que l'application de 
montage vidéo Avid reçoive de l'audio précis à 
l'image. Les fichiers média édités avec une précision 
à l'échantillon sont visibles si vous zoomez sur des 
portions de l'audio importé dans la timeline.

Les applications de montage vidéo Avid sont basées 
sur un montage précis à l'image. Cela signifie que 
dans un projet en 30 i/s, le monteur Avid peut 
appliquer des modifications à 30 emplacements dif-
férents pour chaque seconde de vidéo. Pro Tools est 
basé sur une édition avec précision à l'échantillon. 
Dans une session en 48 kHz, il existe potentiel-
lement 48 000 emplacements éditables pour 
chaque seconde d'audio. 

Lorsque Pro Tools exporte une séquence, il doit 
s'assurer que les fichiers média audio sont alignés 
par rapport aux limites d'une image. Pour cela, il 
se peut qu'il faille diviser un clip audio existant 
en trois clips. Par exemple, l'illustration suivante 
représente un clip vidéo de 5 images et un clip audio 
correspondant. Dans Pro Tools, il est possible que 
les clips audio ne soient pas alignés par rapport aux 
limites d'une image vidéo.

Le clip audio original ne s'aligne pas sur les limites des 
images vidéo

1 clip audio
Pro Tools

Clip vidéo de
5 images
Chapitre 3 : Workflows I
Pour exporter des clips audio précis à l 'image, 
Pro Tools divise le média audio sur les limites des 
images et remplit les vides éventuels par du silence. 
L'illustration suivante représente les clips audio 
obtenus qui sont exportés dans l'application de 
montage vidéo Avid.

Pour réduire le nombre de fichiers d'édition précis à 
l'image, le monteur Pro Tools peut réaliser un 
bounce sur disque pour chaque piste (ou utiliser les 
bus pour les enregistrer sur des pistes audio) plutôt 
que d'exporter les pistes qui contiennent tous les 
points d'édition audio. 

Clips audio exportés alignés par rapport aux limites 
des images

3 clips audio
exportés

Clip vidéo
de 5 images

Nouveaux clips audio 
avec silence ajouté
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Exportation d'une séquence à
partir d'Avid Interplay Access 
en tant que séquence AAF 
vers un volume
Cette section décrit comment exporter une 
séquence résidant sur le serveur Interplay sous 
la forme d'un fichier AAF et l'enregistrer sur 
n'importe quel volume.

Cette procédure est particulièrement utile si le 
monteur Avid a enregistré une version mise à 
jour d'une séquence sur laquelle vous travaillez 
déjà dans Pro Tools, et si vous souhaitez utiliser 
un outil de reconformation tiers pour rapprocher 
les différentes versions de cette séquence au sein 
de votre session. 

Pour exporter une séquence enregistrée sous la 
forme d'une séquence AAF :

1  Lancez Avid Interplay Access.

2  Naviguez jusqu'au dossier contenant la séquence 
qui représente la version de la séquence sur laquelle 
vous avez déjà commencé à travailler dans 
Pro Tools. 

3  Effectuez un clic droit sur cette séquence 
originale et sélectionnez Export Selected 

Sequence as AAF.

4  Naviguez jusqu'à l'emplacement du volume dans 
lequel vous souhaitez enregistrer la séquence. Le 
volume et l'emplacement doivent être facilement 
accessibles à partir de votre système Pro Tools. 
Cliquez sur OK.

5  Naviguez jusqu'au dossier Access contenant la 
version de la séquence qui a été enregistrée le plus 
récemment par le monteur Avid.

6  Effectuez un clic droit sur cette séquence mise 
à jour et choisissez Export Selected Sequence as 
AAF.
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7  Naviguez jusqu'à l'emplacement où vous avez 
enregistré la séquence d'origine et cliquez sur OK.

8  Utilisez un outil de reconformation de post-
production tiers pour reconformer votre session 
Pro Tools au nouveau montage.

Contrôle des versions entre 
les monteurs vidéo Avid et 
Pro Tools

Premier enregistrement
Lorsqu'un monteur Avid enregistre une séquence 
pour la première fois sur Interplay, les événements 
suivants se produisent :

• Le système enregistre la séquence dans le 
dossier correspondant sur Interplay (par défaut, 
le dossier Project\nom_projet\nom_chutier).

• Si le monteur Avid enregistre une séquence 
« pour Pro Tools », le système crée un dossier 
Pro Tools dans le même répertoire et enregistre 
le fichier suivant dans ce dossier :
• Nom_séquence_forPT_1

Le monteur Pro Tools extrait la séquence intitulée 
Nom_séquence (ou Nom_séquence_forPT_x, si le 
monteur Avid a enregistré la séquence « pour 
Pro Tools »). 

Lorsque le monteur Pro Tools a terminé l'édition 
audio, il exporte les pistes sélectionnées vers la 
séquence au même emplacement.

Avec Pro Tools versions 10 et ultérieures, le 
monteur Pro Tools a la possibilité d'extraire des 
séquences non-Pro Tools à partir d'Interplay. 
Dans de nombreux cas cependant, le monteur 
Avid a tout intérêt à enregistrer les séquen-
ces explicitement pour Pro Tools afin de 
s'assurer que les vidéos HD soient transcodées 
et que tous les effets vidéo soient calculés.



L'illustration suivante représente la séquence dans 
Interplay Access. Le nom de la séquence ne change 
pas lorsqu'elle est enregistrée sur Interplay.

Les illustrations suivantes représentent la séquence 
dans Avid Interplay Access une fois que le monteur 
Pro Tools a effectué les opérations suivantes :
• Importé la séquence Pro Tools dans une session 

Pro Tools
• Édité et mixé l'audio
• Exporté les pistes sélectionnées vers la séquence 

Pro Tools sur Interplay

Liste de dossiers d'Interplay Access (gauche) et 
séquence (droite)

Liste de dossiers d'Interplay Access (gauche) et 
séquence (droite)

Séquence
enregistrée à

partir du monteur
vidéo Avid, avec

son nom d'origine

Dossier de projet principal

Séquence pour
le monteur

Pro Tools

Dossier Pro Tools
Chapitre 3 : Workflows I
Deux versions de la séquence sont maintenant 
disponibles.

Pour ouvrir la fenêtre d'historique d'un fichier 
dans Interplay Access :

 Effectuez un clic droit sur la séquence et 
sélectionnez Version Control > History.

À cette étape, le monteur vidéo Avid peut extraire 
la séquence nom_séquence_forPT_1 et monter 
directement la séquence ou reporter l'audio dans 
la séquence d'origine. Pour plus d'informations, 
reportez-vous à la section « Réimportation de 
fichiers audio Pro Tools dans l'application de 
montage vidéo Avid » à la page 30.

Boîte de dialogue Version History
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Enregistrements ultérieurs à 
partir des monteurs Avid et 
Pro Tools
À chaque fois qu'un monteur Avid enregistre une 
séquence sur Interplay pour Pro Tools, les événe-
ments suivants se produisent :

• La séquence nom_séquence du dossier de chutier 
correspondant dans Interplay est mise à jour. Le 
nom du fichier reste identique.

• Si le monteur Avid enregistre une séquence 
« pour Pro Tools », le système crée un fichier 
pour le dossier Pro Tools et modifie la partie 
_forPT_x du nom.

Dans l'exemple suivant, le monteur Avid effectue 
les opérations suivantes :

1  Il extrait la séquence intitulée 
nom_séquence_forPT_1, et reporte les nouveaux 
éléments audio dans la séquence d'origine.

2  Il enregistre la version de la séquence avec les 
fichiers audio mis à jour sur Interplay sans 
effectuer de modifications supplémentaires. 

3  Il applique des modifications supplémentaires 
à la vidéo et enregistre la séquence sur Interplay 
afin que le monteur Pro Tools puisse effectuer 
des modifications audio supplémentaires.

L'illustration suivante représente la séquence 
vidéo exportée vers Interplay Access ainsi qu'un 
historique des versions de la séquence. Trois 
versions de la séquence sont désormais présentes 
sur Interplay.

Boîte de dialogue Version History
Guide Pro Tools Avid Interplay
L'illustration suivante représente les séquences 
dans le dossier Pro Tools après que le monteur 
Avid ait enregistré la séquence trois fois. Elle 
montre également l'historique des versions de 
l'une des séquences.

Historique des versions d'une séquence

Deux versions de la version 1 de la 
séquence enregistrées par le 

monteur Pro Tools

Trois séquences Pro Tools, une pour 
chaque enregistrement effectué par le 

monteur vidéo Avid



Suivi des versions
Après de nombreux enregistrements et extractions 
(même s'il s'agit d'une même séquence), le suivi 
de chaque fichier dans les dossiers de séquence 
peut s'avérer compliqué. Il est important que les 
utilisateurs Avid et Pro Tools communiquent afin 
d'indiquer à quel moment un fichier est prêt et sur 
quel fichier travailler ensuite. La plupart du temps, 
il est conseillé de travailler sur la version la plus 
récente.

Pour accélérer la communication, vous pouvez 
utiliser le service de messagerie disponible dans 
Interplay Access. 

Vous pouvez utiliser Interplay Administrator 
pour activer les notifications par courrier 
électronique pour Interplay (et configurer les 
utilisateurs qui reçoivent ces notifications). 
Pour plus d'informations, consultez le Guide 
d'administration d'Avid Interplay Engine et 
d'Avid Interplay Access. 
Chapitre 3 : Workflows I
Pour envoyer une notification par courrier 
électronique à propos d'une séquence :

1  Lancez Avid Interplay Access et accédez à la 
séquence pour laquelle vous souhaitez envoyer 
une notification. 

2  Sélectionnez Messenger > Send Link To.

La fenêtre de notification par courrier électronique 
s'affiche avec un lien vers la séquence. 

3  Renseignez les informations et cliquez sur Send. 
Le destinataire reçoit un courrier électronique 
contenant un lien vers le fichier et des informations 
supplémentaires, le cas échéant.

Envoi d'une notification par courrier électronique à 
propos d'une séquence

Fenêtre Messenger
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